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Audio Control User Guide for Hosts

Introduction

. This guide provides instructions to Meeting Hosts on how to:
® InterCall

e Configure Reservationless-Plus audio conference controls for use in a
meeting room.
www.intercalleurope.com e Start a web meeting with InterCall audio conference controls.
e Host a web meeting with InterCall audio conference controls.

The following options are available for adding audio to your web meetings. Your
administrator will know what is configured for your site:

e InterCall's Reservationless-Plus Audio Conferencing - InterCall’s
integrated audio conferencing controls provides advanced call capabilities,
allowing hosts and presenters to control the audio conference from the web
meeting interface.

e Built-in VolP - Adobe Connect broadcasts audio in meetings or training
sessions using VolP and the microphones on attendees’ computer systems.

e Universal voice audio - Universal voice enables Adobe Connect to
broadcast all telephone-based audio into a web meeting room over VolIP.

Configuring your Reservationless-Plus Audio Controls
for Use

CREATING AN AUDIO PROFILE
Meeting Hosts can create an audio profile by following these steps:

Note: Keep your InterCall Welcome Email or Welcome Packet handy to create a new audio profile.
STEP ' ACTION

1 In Adobe Connect Central, click My Profile > My Audio Profiles.
2 Click New Profile.
3 Select InterCall in the Provider drop-down menu and enter

Reservationless-Plus in the Profile field.

My Profile | Edit My Preferences | My Audio Profiles | My Audio Providers | Group Memberships | Organization

Mew Audio Profile

Enter Profile Information

Provider: | interCall s

Profile Name: # Reservationless-Plus

Conference Code: =+ 123456

Leader Pin: # 0101

You can enter any Profile Name you choose. It is not limited to just
Reservationless-Plus.

4 Enter your Conference Code and Leader PIN as shown on your InterCall
welcome email or welcome packet.
5 Click Save. Your audio profile will populate with your conference number.

west interCall is a
subsidiary of

» West Corporation



@) InterCall

EDITING OR DELETING AN AUDIO PROFILE
You can change the profile name, and enable or disable an existing audio profile.

STEP ACTION

1 In Adobe Connect Central, click My Profile > My Audio Profiles.
2 Select a profile and click Edit.

3 Change the profile name or status and click Save.

4 To delete an audio profile, select it and click Delete.

ASSOCIATING AN AUDIO PROFILE WITH A MEETING
When you associate an audio profile with a meeting, you include the audio conferencing settings as part of your
web conference.

STEP ACTION

1 You can do one of the following:
¢ Create a meeting and enter the required information (click

Meetings > New Meeting).
e Open an existing meeting and click the Edit Information tab.
2 In the Audio Conference Settings section, select the Include this audio

conference with this meeting radio button. In the drop-down menu, select
the Profile name as you entered it (e.g. Reservationless-Plus).

' Do not include any audio conference with this meeting.

& Include this audio conference with this meeting: |Reseruation|ess—Plus;|
(Please note that audio conference setting changes would be effective for new mesting sessions only.)

' Include other audio conference with this meeting.

Conference Number(s): |

Moderator Code: |

Participant Code: |

Note: If you change the audio profile once you start the meeting, the new audio conference
settings take place only after you close and restart the meeting. Wait a few minutes to see the
changes appear.

3 Click Save.

Starting a Web Meeting using InterCall Audio Conference Controls

FROM THE AUDIO MENU
STARTING AN AUDIO CONFERENCE USING AN AUDIO PROFILE

Once you have created an audio profile and associated it with a meeting, Adobe Connect uses the dial-in steps in
the profile to connect to InterCall and start the meeting.



@) InterCall

4a

ACTION

Navigate to the Meeting Information page for a specific meeting.
Click Enter Meeting Room.

From the Audio menu, select Start Meeting Audio.

Al

Adobe

Meeting Layouts Pods Audio ) - o -~ PO

=

Start Meeting Audio...

The Start Meeting Audio dialog box appears. how you
want attendees to join the meeting’s audio:
e Using Computers (via VolP)

e Using Phone (via InterCall audio conferencing)

e Both (via InterCall audio conferencing or via computer
microphone)

If you select Using Computers only, go to step 4a.

If you select Using Phone only, go to step 4b.

If you check both options on the screen, go to step 4c.
Start Meeting Audio [

How do you want attendees to join this meeting's audio
conference?

# Using Computers @)
[] Enable micraphone rights for participants

¥ Using Phane @

[ Start broadcasting telephony audio

If you select Using Computers, you can also choose to enable
microphone rights for participants. This option gives participants the ability
to talk through the microphone so other participants can hear them during
the meeting.

Make sure to deselect the Using Phone option if you select this option.

To enable your microphone so others can hear you, under the
Microphone icon, select Connect My Audio.

A Meeting  Layouts Pods  Audio
Adobe

Connect My Audio

A Microphone icon will appear next to your name in the participant list
indicating that you are connected by Microphone. The icon appears only
when you are actively speaking.
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4b

4c

If you select Using Phone, you can also start to broadcast telephony
audio. This will allow you to broadcast your voice either via the phone or
via computer. By default only hosts and presenters can broadcast audio.
Make sure to deselect the Using Computers option if you select this
option.
You and your participants will see the Join Audio Conference dialog box
appeatr.

= i E
This meeting's audio conference was successfully started.
How would you like to join the meeting's audio conference?

(=) Dial-out [Receive a call from the meeting]

+1-415-555-1234
(+ Country code - Areafcity code - Mumber Eg. +1-415-555-1234)
() Dial-in to the Audio Conference via Phane

Jain Cancel

If you select the Dial-out radio button, enter your telephone number as
shown in the example (e.g. +Country Code-Area/City Code-Number) and
click Join. Shortly thereafter, you will receive a phone call asking you to join
the audio conference. Follow the audio prompts to join the conference.
If you select Dial-in to the Audio Conference via Phone, then follow the
instructions in the dialog box to join the audio conference.
By checking both Using Computers and Using Phone options, you
present all options to join the audio portion of the meeting. To start the
meeting audio, go to the Audio menu and select Start Meeting Audio. You
and your participants will receive a Join Audio Conference dialog box with
three options to join the audio:

e Dial-out

e Dial-in
e Using Computer

This meeting's audio conference was successfully started.
How would you like to join the meeting's audio conference?

(®) Dial-out [Receive a call from the meeting]

(+ Country code - Area/city code - Mumber Eg. +1-415-555-1234)
() Dial-in to the Audio Conference via Phone

() Using Computer

Cancel

Attendees must select an option to join. If attendees join using multiple
methods in a single web meeting, then you will have a blend of attendees
using the phone and VolP during the meeting.
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STOP MEETING AUDIO

The Host can stop the meeting audio at any time during the meeting. This action will disconnect the meeting
host(s), presenter(s) and all attendees from the audio conference.

STEP ACTION

1 From the Audio menu, select Stop Meeting Audio. All audio conference
lines will disconnect from the meeting.

Stop Meeting Audio

Change Meeting Audio Mode...

Stop Audio Broadcast

Call A New User...

Microphone Rights For Participants

CHANGE MEETING AUDIO MODE
The Host can change the audio mode at any time during the meeting. This allows the Host to modify how
attendees join the meeting either via audio either via audio conference or via computer (VoIP).

1 The Change Meeting Audio Mode dialog box appears. You can select
how you want attendees to join the meeting’s audio:
e Using Computers (via VolP)

e Using Phone (via InterCall audio conferencing)
e Both (via InterCall audio conferencing or via computer microphone)
If you select Using Computers only, go to step 2a.

If you select Using Phone only, go to step 2b.
If you check both options on the screen, go to step 2c.

How do you want attendees to join this meeting's audio
conference?

[+ Using Computers (&)
[] Enable microphaone rights for participants

[+ using Phone &)
[ Start broadcasting telephony audio

Cancel
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2a

2b

If you select Using Computers, you can also choose to enable
microphone rights for participants. This option gives participants the ability
to talk through the microphone so other participants can hear them during
the meeting.

Make sure to deselect the Using Phone option if you select this option.

To enable your microphone so others can hear you, under the Microphone
icon, select Connect My Audio.

A Meeting  Layouts Pods  Audio
adobe

Connect My Audio

A Microphone icon will appear next to your name in the participant list
indicating that you are connected by Microphone. The icon appears only
when you are actively speaking.
If you select Using Phone, you can also start to broadcast telephony
audio. This will allow you to broadcast your voice either via the phone or
via computer. By default only hosts and presenters can broadcast audio.
Make sure to deselect the Using Computers option if you select this
option.
You and your participants will see the Join Audio Conference dialog box
appear. |

S
This meeting's audio conference was successfully started.
How would you like to join the meeting's audio conference?

(®) Dial-out [Receive a call from the meeting]

+1-415-555-1234
(+ Country code - Area/city code - Number E.g. +1-415-555-1234)
() Dial-in to the Audio Conference via Phane

Join Cancel

If you select the Dial-out radio button, enter your telephone number as
shown in the example (e.g. +Country Code-Area/City Code-Number) and
click Join. Shortly thereafter, you will receive a phone call asking you to
join the audio conference. Follow the audio prompts to join the conference.
If you select Dial-in to the Audio Conference via Phone, then follow the
instructions in the dialog box to join the audio conference.
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2c

By checking both Using Computers and Using Phone options, you
present all three options to join the audio portion of the meeting. To start
the meeting audio, go to the Audio menu and select Start Meeting Audio.
You and your participants will receive a Join Audio Conference dialog
box with three options to join the audio:

e Dial-out

e Dial-in

e Using Computer

!nin Audio Conference

This meeting's audio conference was successfully started.
How would you like to join the meeting's audio conference?

(®) Dial-out [Receive a call from the meeting]

(+ Country code - Area/city code - Number Eg. +1-415-555-1234)

(") Dial-in to the Audio Conference via Phone

() Using Computer

Attendees must select an option to join. If attendees join using multiple
methods in a single web meeting, then you will have a blend of attendees
using Reservationless-Plus audio conferencing and VolP during the
meeting.

Note: When changing the meeting audio mode, it is recommended that you notify your

attendees in advance as their lines may be disconnected depending on what option(s) you
choose to enable.

START OR STOP AUDIO BROADCAST
The audio broadcast uses the universal voice line to broadcast all telephone-based audio into a web meeting room

over VolP.
STEP
1

ACTION

To start audio broadcast, select Start Audio Broadcast in the Audio
menu. A pop-up message will appear in the top right corner of your
screen confirming your selection.

I Audio Bridge Connected

Connected to the audio bridge. Currently
broadcasting audio.

To stop audio broadcast, select Stop Audio Broadcast in the Audio
menu.

Audio

Stop Meeting Audio
Change Meeting Audio Mode...

Call A New User...

Microphone Rights For Participants

A pop-up message will appear in the top right corner of your screen
confirming your selection.
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CALL A NEW USER
The host can dial out to an individual to include as a participant in the audio conference call.

STEP ACTION

1 From the Audio menu, select Call a New User.

2 The Call Telephone User dialog box appears. Enter the Name and
Phone Number as shown (e.g. +Country Code-Area/City Code-Number).
wCallJelephoneliser

Enter the user's name and phone number to call.

Mame

[ Kathy Smith |

Phone Number

l+1-415-555-5555 l
(+ Country code - Area/city code - Mumber Ejg. +1-415-555-1234)

w

Click Call.
4 To cancel the call, click Cancel.

MICROPHONE RIGHTS FOR PARTICIPANTS

When using computer or VoIP or a blend of both Reservationless-Plus audio and VolIP, the Host can enable
microphone rights for attendees. This allows those attendees to speak to the host, presenter(s) and attendees in
the meeting.

STEP ACTION

1 To enable microphone rights for attendees, select Microphone Rights

for Participants under the Audio menu.

Stop Meeting Audio
Change Meeting Audio Mode...

Stop Audio Broadcast

Call A New User...

Microphone Rights For Participants

2 Once you select this option, attendees will see a microphone icon enabled
next to their names in the attendee list.
¥ Participants (1)

£ John Smith ]

Note: The microphone icon will appear for attendees that have joined whether they joined
via computer (VolP) or via phone (Reservationless-Plus). For attendees that joined via
Reservationless-Plus audio, to use the VolP microphone, they must disconnect from the
Reservationless-Plus audio first.
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Hosting a Web Meeting with InterCall Audio Conference Controls

FROM THE ATTENDEE POD OPTIONS MENU KEY BENEFITS

AUDIO STATUS
After participants connect to an audio conference, status icons appear next to their names in the participant list.

Status Icon
Dialing in progress ]
Connected on phone =
VolIP user with Microphone rights @
Muted il
Phone user actively speaking &
VolIP user actively speaking @’?

DRAG AND DROP ATTENDEE MERGE

The meeting host can merge the attendee name with the attendee’s phone number when an attendee uses the
dial-in option.

STEP ACTION

1 To merge the attendee name with the attendee’s phone number in the
attendee pod, select the phone number of the attendee and drag to the
name of the attendee that you want to merge it with.
Attendees (3)

¥ Hosts (1)
48, Hathy Smith &
» Presenters (0)

« Participants (2)

( T 4085551234 J

~=)3

®

]
=
2 4085551234

5

2 A small dialog box appears next to the name of the attendee confirming
the merge. Click once to confirm and the attendee name and phone
number will merge into a one entry on the attendee list. A phone icon will
also appear next to the attendee’s name.

EDITING MY INFO
Meeting hosts can modify his or her own name and/or phone number as it appears in the attendee pod.
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STEP
1

ACTION

To edit your info, go to Pod Options ~ and select Edit My Info in the

drop-down menu.

- =2

Hide

Maximize

ey o |

Change View 4
Attendee Options 4
Change Role 3

Remove Selected User
Mute All Users

Clear Everyone's Status

Preferences

Help

The Edit My Info dialog box appears. You can edit the name and phone
number. Click OK to save your changes, or to cancel your changes, click
Cancel.

Edit Name

Kathy Smith

Enter phone number

415-555-5555 ]

EDITING USER INFO

Meeting hosts can edit an attendee’s name and phone number as it appears in the attendee pod.

STEP
1

ACTION
To edit user info, highlight the name of the attendee that you want to

edit in the attendee list. Then, go to Pod Options =~ and select
Attendee Options in the drop-down menu.

Hide

Maximize

Edit My Info...

Change View 3
Change Role »

Remove Selected User
Mute All Users
Clear Everyone's Status

Preferences

Help
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2

A sub-menu appears. Select Edit User Info and edit the attendee’s name
and phone number.

Edit Name

Mike Jones

Enter phone number

(7738677044 |

Click OK to save your changes, or to cancel your changes, click Cancel.

MUTING AND UNMUTING AN ATTENDEE
The meeting host can mute and/or unmute attendees from the Adobe Connect user interface.

STEP
1

ACTION

To mute an attendee, highlight the name of the attendee that you want to
mute in the attendee list. Then, go to Pod Options =" and select
Attendee Options in the drop-down menu.

Hide

Maximize

Edit My Info...

Change View »
Attendee Options »
Change Role 13

Remove Selected User
Mute All Users
Clear Everyone's Status

Preferences

Help

A sub-menu appears. Select Mute and the attendee’s line will be muted.
A Muted icon will appear next to the name of the participant that is

muted ‘{b

Edit User Info...
Start Private Chat

Enable Video

Request Screen Share

Hang Up

Enhanced Participant Rights

Clear Attendee Status

To unmute an attendee, repeat step 1 and step 2 but select Unmute from
the Attendee Options sub-menu.
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MUTING OR UNMUTING ALL USERS
Meeting hosts can mute and/or unmute all user lines at the same time.

STEP
1

ACTION

To mute all attendees from the meeting audio, go to Pod Options
and select Attendee Options in the drop-down menu.

Hide

Maximize

Edit My Info...

Change View »
Attendee Options »
Change Role 3
Remove Selected User
Mute All Users

Clear Everyone's Status
Preferences

Help

A sub-menu appears. Select Mute All Users and all lines will be muted
in the conference.

Hide

Maximize

Edit My Info...

Change View 4
Attendee Options 4
Change Role »

Remove Selected User

Mute All Users

Clear Everyone's Status

Preferences

Help

NOTE: This action also mutes the Host and Presenter lines as well. You must select #6 on
your telephone keypad to unmute your own line. Attendees can also unmute their own lines
by selecting #6 on their telephone keypad. An alternative would be to utilize the *5/#5 option
on your telephone keypad to mute/unmute all lines except the leader’s.

To unmute all users, go to Pod Options ~ and select Attendee
Options in the drop-down menu. A sub-menu appears. Select Unmute
All Users. All lines will be automatically unmuted.

DISCONNECT AN ATTENDEE FROM THE AUDIO

The meeting host can disconnect an attendee from the meeting audio. Please note that this does not prevent the
attendee from rejoining the audio conference call.
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STEP ACTION
1 To disconnect the attendee from the meeting audio, highlight the name of
the attendee that you want to disconnect in the attendee list. Then, go to

Pod Options and select Attendee Options in the drop-down menu.
Hide
Maximize
Edit My Info...
Change View 4
Change Role »

Remove Selected User
Mute All Users

Clear Everyone's Status

Preferences

Help

2 A sub-menu appears. Select Hang Up and the attendee’s line will be
disconnected.
NOTE: This action does not prevent the attendee from rejoining the audio conference call. If
this is your intention, then you should choose the Lock Conference option on your
Reservationless-Plus account. This will prevent attendees from joining the audio including
the InterCall Operator.

CREATING BREAKOUT ROOMS

Breakout rooms are subrooms that can be created within a meeting or training session. They are useful for
splitting a large group into smaller groups that can talk and collaborate with each other.

Note: To use the breakout rooms feature, you must have the subconferencing feature enabled on your InterCall Reservationless-Plus account.
Once enabled, your account can handle up to 15 breakout rooms with the maximum number of ports set up on your account. If you do not
know if your account has subconferencing feature enabled or the maximum number of ports per meeting, please contact InterCall customer
service or go to www-emea.intercallonline.com to see your account details.

STEP ACTION
1

To create a breakout room, click on Breakout Room View = in the
Attendee Pod. A new Breakout Room View will appear.

Attendees (2)

w'n
Start Breakouts 4

* Main Meeting (2)
& Kothy smith
(9] John Jones
» Breakout 1 (0]

]

» Breakout 2 (0)

0006 8

» Breakout 3 (0)
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2

4a

4b

Before you start the breakout sessions, you must set up the number of
breakout rooms that you want (up to 15 is supported on your
Reservationless-Plus account). To add a breakout room, click on Create a

New Breakout Room i and add the number of breakout rooms that you
want. The additional breakout rooms will appear in the Attendee Pod.

Attendees (2)

-

Start Breakouts

&2, Kothy smith
(% John Jones
Breakout 1 (0]

v

L4

il

i1
h
aaaaa@@m

Breakout 2 (0]

-

Breakout 3 (0]

4

Breakout 4 (0)

L4

Breakout 5 (0]

To add an attendee into a breakout room, you can either (a) evenly
distribute them into the breakout room(s) or (b) you can individually add
them into the room of your choice. For option (a), go to step 4a or for
option (b), go to step 4b.

To evenly distribute attendees into the breakout rooms, click Evenly

Distribute from Main[z]. Attendees will be distributed evenly amongst
the breakout rooms.

To add attendees into the breakout room your choice, left-click the
attendee’s name in list and select the breakout room.
Attendees (2)

Start Breakouts b4

&8 Kathy Smith
Main Meeting 2 John Jones -

Breakout 1 » Breakout 1 (0)

&)
[+)

&) 2]

Breakout 2
Breakout 3
Breakout 4
Breakout 5

» Breakout 2 (0)

» Breakout 3 (0)

» Breakout 4 (0}

(< QU= < < <

» Breakout 5 (0)

The attendee’s name will then appear under the breakout room that you
selected.

Attendees (2)

[ g ]

Start Breakouts bl

&, Kathy Smith
* Breakout 1 (1)

» Breakout 2 (0)

& Rroaloaod 2000

O@E

E)

200

. . Start Breakouts
To start the breakout session(s), click Start Breakouts

in the Attendee Pod.
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BRINGING ATTENDEES INTO THE MAIN MEETING

The Host can bring attendee(s) back into the Main Meeting at any time during the breakout session(s).

STEP
1

ACTION

To bring an attendee back into the main meeting, left-click on the
attendee’s name in the Attendee list and select Main Meeting.

Attendees (2) =-

End Breakouts g

& Kathy smith
» Breakout 1 (0)

» Breakout 2 (0]

v Breakout 3 (1)

Main Meeting
Breakout 1
Breakout 2
Breakout 3
Breakout 4
Breakout 5

» 2 JohnJones

» Breakout 4 (0)

» Breakout 5 (0)

ENDING BREAKOUT ROOMS

STEP
1

ACTION

' 000@@

To end the breakout session(s), click on End Breakouts

End Breakouts ]

joined to the main meeting.

in the Attendee Pod. Attendees will be automatically

Note: Attendees’ names will still appear under their individual breakout rooms in the event

that you want to start another breakout session.

REMOVING AUDIO RIGHTS FROM ALL
This option allows the host to disconnect all Reservationless-Plus audio and VolIP lines from all presenters and

attendees.

STEP
1

ACTION

To remove audio rights from all, go to Pod Options

Remove audio rights from all.

Hide

Maximize

Edit My Info...

Change View »
Attendee Options »
Change Role »

Remove Selected User
Mute All Users
Unmute All Users

Clear Everyone's Status

Remove audio rights from all

Preferences

Help

~ and select
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FROM THE SPEAKER MENU
MUTING AND UNMUTING YOUR COMPUTER SPEAKERS

Meeting hosts, presenters and participants can mute or mute their computer speakers from the web meeting
interface.

STEP ACTION

1
To mute your computer speakers, under the Speaker icon “ drop-

down menu, select Mute My Speakers.
2 To unmute your computer speakers, under the Speaker icon

“droi—down menu, select Unmute My Speakers.

Unmute My Speakers

Adjust Speaker Volume...

MUTE CONFERENCE AUDIO ONLY
The Host can mute conference audio only when connected to the meeting via phone. This option mutes the
computer audio when you are actively speaking via the phone on your Reservationless-Plus audio conference.

STEP ACTION

1 . .
To mute conference audio only, under the Speaker icon “ drop-

down menu, select Mute Conference Audio Only.
Mute My Speakers

Mute Conference Audio Only

Adjust Speaker Volume...

To unmute conference audio, under the Speaker icon “ drop-down
menu, de-select Mute Conference Audio Only. At this time, the host will
hear the audio through both the computer and phone.

Tip: Unmuting conference audio while connected to the phone is not recommended because
it can be distracting for the host when speaking in the meeting.

ADJUST SPEAKER VOLUME
The host, presenter(s), and attendees can adjust their computers’ speaker volume during the meeting.

STEP ACTION

1
To adjust the speaker volume, under the Speaker icon “ drop-

down menu, select Adjust Speaker Volume.
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2 The Adjust Speaker Volume dialog box appears. Drag the slider to adjust the
speaker volume for the meeting to your liking. Click OK to confirm the
adjustment. Or, click Cancel to cancel the adjustment.

%

Drag slider to adjust speaker volume for this meeting.

Speaker i - : 8
Loww High

[ OK ] [ Cancel ]

FROM THE PHONE MENU

MUTING AND UNMUTING YOUR PHONE LINE
Meeting hosts, presenters and participants can mute or mute their audio conference lines from the web meeting
interface.

STEP ' ACTION

1 To mute your phone, under the Phone icon drop-down menu,

select Mute My Phone.
E susanl {(Sharing) - Adobe Connect
!j:l Meeting  Layouts Pods  Audio s - L - o - & -

- Disconnect My Phone
To unmute your phone, under the Phone icon drop-down menu, de-
select Mute My Phone.

g9 susanl (Sharing) - Adobe Connect

!j-:«l Meeting  Layouts Pods Audio g - ts ~ o - &y -

Disconnect My Phone

DISCONNECTING MY PHONE
Meeting hosts, presenters and participants can disconnect their phone lines at any time during the meeting.

STEP ACTION

1 To disconnect, under the Phone icon drop-down menu, select

Disconnect My Phone. Your phone will be automatically disconnected.

FROM THE NOTIFICATION MENU
The notification menu displays the Reservationless-Plus audio conference dial-in details to join the meeting.
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STEP ACTION
1 To view the audio conference dial-in details, select the Notification

drop-down menu.
2 The Dial-in details pop-up appears. Select the View info button. The
audio conference information appears for the meeting.

B Dial-in details

View info

Click the o button to exit out of the dial-in details.
FROM THE MEETING MENU
RECORDING A MEETING

STEP « ACTION

1 From the menu bar, select Meeting and then Record Meeting.
2 In the Record Meeting dialog box, enter a name and summary for the meeting
recording.

Note: A recording icon (red circle) appears in the menu bar to indicate that the meeting is being
recorded. If a problem occurs during the recording, an error message appears in the upper right
corner of the window. You can try to reconnect to the conference audio, record the meeting without
audio, or stop recording the meeting.

ENDING THE MEETING

Once you have completed your meeting, you must end the meeting properly for all attendees to be disconnected
from both the Reservationless-Plus audio and the Adobe Connect web conference.

STEP ACTION

1 To end the meetini, select End Meeting under the Meeting menu.
Meeting | Layouts  Pods

Manage Meeting Information
Manage Access & Entry L3
Change My Role »

Preferences...

Audio Setup Wizard...

Record Meeting...
Switch To Prepare Mode
Enable Presenter Only Area

Full Screen

Exit Adobe Connect
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2 The End Meeting window appears. To end the integrated audio
conference in addition to the web meeting, select the End Integrated
Audio Conference checkbox.

T ——

When you end the meeting, all attendees will be removed from
the meeting room.

[¥ End Integrated Audio Conference

Show this message to everyone.

The host has ended this meeting. Thank you for attending.

[] Open this URL for everyone.

[http:f’f’mwv.intercall_com ]

Optionally, specify a message that you want to show and a URL to open in
the attendees’ browsers upon ending the meeting.

3 Click OK to end the meeting. Or, click Cancel if you do not wish to end the
meeting.

For more information regarding InterCall or Adobe Connect, visit www.intercalleurope.com.




